First Word

[image: image1.png].
NOMSef3ad



[image: image8.jpg]


Volume 11, Issue 12
December  2011  

[image: image9.wmf][image: image10.wmf]

[image: image11.wmf]prepare our hearts to again hear the story of God’s intervention into the lives of humanity with his great display of Christmas Grace in the form of the baby Jesus.  Our Christmas Sunday worship will be a departure from years past with a single service on Sunday at 6 p.m. on Christmas Night.  We hope that this will give all of our families time to enjoy a traditional Christmas Day celebration and then come to church to sing the great Christmas hymns and hear a word about God’s goodness on that 1st Christmas Day.  We will again offer a Christmas Day meal to any and all who may be alone on Christmas Day with mealtime at 1 p.m.

December will go as quickly as the rest of the year, but let’s do our very best to give appropriate praise to the one who has given us the best gift of all.  Let us not allow the commercialism of the season to overshadow the reason that we celebrate.  That reason is not about lights and tinsel, stockings hung on the mantle or gifts under the tree.  The reason that we celebrate is that God has not left us in our sinful state, but has sent his one and only son to lead us back to the place of our origin…..in the heart of God.

Christmas is a joyful time and we who call ourselves Christian should be the most joyful of all.  Let us celebrate in ways that honor God and the greatest gift of all time…..the one we call Jesus.

Thanks to all who have returned their stewardship pledges.  It looks like another great year ahead because you have pledged to make it so.  My prayer for each of you is that this Christmas will find you discovering a new depth of thankfulness for the one who has given us the joy without end.

Praying God’s best for you,

Your brother in Christ,

Pastor Dave

I truly believe that if we keep telling the Christmas story, singing the Christmas songs, and living the Christmas spirit, we can bring joy and happiness and peace to this world.


Norman Vincent Peale
“FAITH” SERVES

First Baptist of Raytown hosts a wonderful play featuring the Life of Christ.  Faith has 19 tickets for the showing on December 9th at 7:00pm.  They are free tickets and if anyone wants a ticket, please contact Kim Compton at (816) 443-3363.
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ADVENT BIBLE STUDY

Pastor Hackett is leading an Advent Bible Study in the library at 1:30 each Monday afternoon until Christmas.  The study will focus on the lectionary Bible readings for the season.  All are welcome to this series.
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Once again it is your opportunity to purchase a poinsettia in honor or in memory of someone special.  The cost is $10.00.  We are ordering 25 plants this season to display and all money collected over that amount will be put toward the Christmas Shoebox Project.

If you would like to purchase one or more, please fill out an order form and place it in the offering plate with your check for the number purchased.  Please have your orders in by December 11th.
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Faith Music
You won’t want to miss the celebration of Christmas presented by our Faith Singers and Faith Bells.

The Faith Singers will present their Christmas Cantata, “Celebrate His Name,” during both services on December 11.  

The Faith Bells will be performing at both services on December 18, as well as during the 6:00pm and 8:00pm Christmas Eve Services.  

Please join us to share in the joy of their music and the sounds of the Christmas season.
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“Candlelight, Carols and Communion”
December 24

6:00pm, 8:00pm & 11:00pm

As is our custom, we will have three opportunities to celebrate the coming of Christmas on Christmas Eve.  This year our Faith Bells will perform at the 6:00 and 8:00 pm services.  Patty and friends will host a beautiful refreshment table after the 6:00 and 8:00 pm services and before the 11:00 pm service.  We will take an offering at the communion table for use in 2012 in our emergency relief “love” fund.  

Christmas Eve is a wonderful time to invite friends and family to worship the “real” reason for the Christmas season.  We will look forward to seeing you at this most festive and holy season of the year.

CHRISTMAS DAY
We will have a single Worship Service on
Sunday, December 25 at 6:00 pm



Logos - Diane Walker and her crew have planned the following themes and menus for the month of December: 

12/7
Pajama Night

Breakfast

12/14
Jesus Birthday Party
Hamburgers, Chips

[image: image18.bmp]Our Logos Children’s Christmas program will be held on Wednesday, December 21 at 7 p.m.  The air will be filled with the sound of children singing and the old, old story of Christmas as told in the gospels.  It is rumored that Santa Claus may make a stop at Faith to hear the children’s Christmas wishes.   Refreshments will be served following the children’s program.  Please come and support our children as they learn and sing about the arrival of a Savior.

[image: image3.png]United
Methodist
Women




Sunday, December 11, following the 10:45 am service, Faith UMW will be celebrating another year of sisterhood and working in missions.  The combined night and day units of UMW will have lunch here at Faith UMC.  Lunch will be catered by HyVee.  The cost of the meal is $10.00 for two entrees, three sides, dessert and drink.  Please make your reservation with Mary Harper.  You may pay at the time of reservation or the day of the luncheon.  We encourage all women of the church to come and bring a guest.
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NEW YEAR’S EVE WATCH PARTY [image: image4.wmf]
Each of the last several years we have invited our Faith friends to church on December 31 for a New Year’s Eve celebration.  Would you like to join us this year?  We will gather at 8 p.m. with finger foods, snacks, soft drinks and coffee.  We will join together as a community in fun and games and, just before midnight, we will participate in an old Methodist tradition as we enter into John Wesley’s Covenant Renewal Service.  At the stroke of midnight we will be gathered in prayer with some of our best friends.  Hope you will join us in welcoming 2012 in a fun and prayerful way.

NEW YEAR’S DAY
We will have a single Worship Service on Sunday, January 1, 2012 at 10:45.
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NEWSLETTER BY EMAIL?

Receive Newsletter by email

admin@gvfaithumc.org Thanks! Jean Weiner

                           
	Faith United Methodist Church

1950 SW Eagles Parkway

Grain Valley, MO 64029

Telephone:(816) 847-0008
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	Forwarding Service Requested
	


	December 2011

	Sunday 
	Monday
	Tuesday
	Wednesday
	Thursday
	Friday
	Saturday

	
	
	
	
	1
7:00 pm The 2nd Half
	2

	3
10:00 am Women’s Bible Study – Faithful Abundant True



	4
4:30 pm Confirmation Class
5:30 pm Youth

7:00 pm Choir
	5
1:30 pm Ladies Bible Study

6:00 pm Boy Scouts

6:00 pm Church Council
	6
7:00 pm Leading Christ’s Way
7:00 pm UMW

7:00 pm Wolf Den
	7
6:00 pm Bells of Faith

6:00 pm LOGOS

6:00 pm Teen Bible Study
	8
Girl Scouts

7:00 pm The 2nd Half


	9

	10
10:00 am Women’s Bible Study – Faithful Abundant True



	11  Christmas Cantata

8:15 & 10:45 services

4:30 pm Confirmation Class

5:30 pm Youth
7:00 pm Choir
	12
10:00 am UMW

1:30 pm Ladies Bible Study

6:00 pm Boy Scouts


	13
7:00 pm Leading Christ’s Way
	14
6:00 pm Bells of Faith

6:00 pm LOGOS

6:00 pm Teen Bible Study
	15
11:30 am Young at Heart Luncheon


	16
Youth All-Nighter
	17
10:00 am Women’s Bible Study – Faithful Abundant True

	18

Noon Fellowship Luncheon 
4:30 pm Confirmation Class

7:00 pm Choir
	19
1:30 pm Ladies Bible Study

6:00 pm Boy Scouts

7:00 pm Cub Scouts
7:00 pm Trustees
	20
8:30 am Men’s Breakfast

	21
6:00 pm Bells of Faith
6:00 pm Teen Bible
7:00 pm LOGOs Christmas Program
Study
	22
Girl Scouts
	23
	24
Christmas Eve Services
6:00/8:00/11:00pm

	25

Christmas Service
6:00 pm
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	26
1:30 pm Ladies Bible Study

6:00 pm Boy Scouts


	27
7:00 pm Wolf Den


	28
6:00 pm Bells of Faith


	29
	30
	31  NEW YEAR’S EVE Watch Party

8:00-Midnight
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Dear Faithful Friends,





How is it possible that Christmas is almost here again?  Didn’t we just get the lights down a little while ago and now it is time to put them up again?  Where has this year gone?  Haven’t you wondered that too?  I hope what they used to say about time flying when you are having fun is really true, because if it is, I am having a great time.





It is a busy, busy place here at Faith.  I am glad.  That means that folks are busily engaged in the work of the church which also means we are busy being the hands and feet of Jesus Christ.  November was a fantastic month of ministry.  452 Christmas shoeboxes were sent to children around the globe!  65 women in retreat, listening to the voice of God!  More than 100 winter coats sent to the homeless of Kansas City!  Another successful partnership with the Grain Valley Assistance Council to provide Thanksgiving baskets to more than 100 families in our community who may have otherwise been without the fixings for a traditional Thanksgiving dinner!  It was a good month for ministry.





And now we enter into the 4 weeks of the Advent Season.  We begin to turn our hearts toward the hillside where the shepherds heard the angels proclaim the good news that a Savior had been born.  We begin to think of a quiet stable scene where a young mother gives birth to one who we know as Christ the King.  Christmas is coming and it is time to prepare ourselves for the King of Kings and the Lord of Lords, the Prince of Peace desires to take up residence in our hearts.  Have we been too busy to get ready?





In the weeks ahead there will be several opportunities aimed at helping you to keep Christmas in your heart.  The Monday afternoon ladies Bible study is looking at the lectionary readings this month.  Each of the lectionary readings is aimed at preparation for the Christ Child.  All the ladies of the church are welcome.  We meet in the church library at 1:30 on Mondays.  The church choir will present their Christmas Cantata on Sunday, December 11 at both services.  The title of their musical presentation is “CELEBRATE HIS NAME!  PROCLAIM HIS BIRTH”.  Last year’s production was outstanding and this year will be more of the same. The choir is directed by Rachael Marchetti and accompanied by Skye Clements.  We will have 3 opportunities for sacred worship on Christmas Eve at 6, 8 and 11 p.m.  Each service will have special music (Faith Bells will play at the 6 & 8 p.m. services).  We will have “Candles, Carols and Communion” as we
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Living for Jesus


FAITH at Work





Pastor


David Hackett





Sunday Worship


8:15 am & 10:45 am


Sunday School


9:30 am


Sunday Evening


5:30 pm


7th-12th grade Youth Group





Monday


1:30 p.m. 


Ladies Bible Study





Wednesday


6:00 pm-7:30 pm 


Logos Children’s Program


K-5th grade Sept- April


Digging Deeper – Teen Bible Study


6th grade up








Follow


Answer His call


Invite others to His fellowship


Teach the Word


Honor Him








Articles for Newsletter need to be submitted to Pastor or Jean by


 Monday, December 26th


















































































































































ANNUAL STEWARDSHIP CAMPAIGN





Each member of Faith United Methodist should have received a brochure about stewardship for 2012.  That informational brochure gave you an opportunity to make a Faith pledge regarding your participation in the church.  You may remember your membership promise to support the church with your prayers, presence, gifts, service and witness.  We want very much to build up the church by the good use of your gifts and talents.  Please return your stewardship “faith” pledge so we can do just that in the New Year.  We look forward to hearing from you in this important task of promise keeping.








�


ARE YOU GOING TO BE ALONE ON CHRISTMAS DAY? 





It has become our tradition in the last few years to serve a Christmas Dinner on Christmas Day for those in our church and community who might not have a place to go on Christmas Day.  We do not want anyone to be alone on this holiest of days unless they wish to be.  Our chief cooks, Don and Cathy Basinger and their noble assistants, Jerry and Sarah Vaughan, are making plans again for a full Christmas Dinner with Turkey and Ham and all the Christmas fixings.  If you would like to assist with the dinner or to eat the dinner, we would welcome your participation.  A sign-up sheet is located at the information table at the back of the church for volunteers and for diners.  Please spread the word in your neighborhood about this opportunity for Christmas Day food and fellowship.  Lunch will be served at 1:00 p.m.  








  








To the editor:


This past summer, Faith United Methodist Church in Grain Valley, visited Pike County, KY, but not as tourists or even for business. They were here to donate serious sweat, toil and hard labor.


  During the time Faith united Methodist was serving in Pike County, homes had rotten porches and steps replaced, wheelchair ramps built, homes painted and shingles, windows and siding replaced, a new tub surround was installed with new tub and shower, trailer roofs were sealed against leaks, ramps were covered with non-skid and handicapped ramps were built, a clothing giveaway was organized and hosted, and food was delivered.  Faith United Methodist participated in many and possibly all of these services done free of charge for our low-income elderly and disabled.


  We at Helping Ease Life’s Poverty want to take this opportunity to thank them publicly and pray God’s blessings upon them.





Charles “Monk” Sanders


Director, Helping Ease Life’s Poverty


Phelps, KY




















� I want to thank you so much for not only all you did for us as a family during our loss of Olline but all you did for her during her life.  Her church family meant so much to her and all of you took such great care of her.  She was so honored with her prayer shawl you gave her.  She kept it close to her right to the end.  Thank you for the visits you all made to her, they meant a lot to her as well as the family.  Thank you Dave for all your visits and prayers, it made the end easier for her as well as the family.  Thanks to all of you that contributed to the food and service you gave us at the dinner following the service.  We could not have had better food or service at a five star restaurant.  Our extended family was so impressed that a tradition like a “family dinner” put on by the church still existed.  You are all truly a church family that is here to serve and help one another.  Thank you so much for your thoughtfulness during our time of sorrow.





Alice Young and family





* * * * *





Dear Faith UMC Ladies,





I’d like to say a heartfelt thank you for the beautiful shawl made for me on my wedding day.  It is so special and will make me think of my dream wedding celebration for years to come as I wrap it around my shoulders for warmth.





Sincerely, thank you.


Hannah Dudley





* * * * *





Thank you for the Prayer Shawl and most of all – thank you for the prayers at this difficult time.  Kim and Jason have a wonderful church home.





Connie Martin





* * * * *





Friends at Faith:


What a blessing it is to be part of a church that shows its love and kindness in so many ways.  Pastor’s prayers and presence so many times and all the prayers, calls, cards, visits, food, offers of help and moral support.  Our grateful appreciation.





Don and Norma Smith














�Christmas Cards





Again this year we would like to help you deliver your Christmas Cards to members of the Faith church family.  Just deliver your cards to the table at the back of the church where they will be sorted alphabetically by family name and delivered each Sunday morning at church.  If you would like to make a donation for the service, we would encourage you to do that Christmas Eve to the Emergency Relief “love” fund.








�FELLOWSHIP LUNCH





Our Fellowship Lunch this month will be held after the 10:45 am service on December 18th.  The Faith hospitality team will supply bread and lunchmeat for sandwiches and we ask church members to bring a side dish or dessert to share. 





Please join us for good food and fellowship. 




















PLEASE JOIN US TO CELEBRATE THE 50TH WEDDING ANNIVERSARY OF





LOUIS AND JUDY BILLUPS





DECEMBER 11, 2011


2 PM – 4 PM





FAITH UNITED METHODIST CHURCH


1950 SW EAGLES PARKWAY


GRAIN VALLEY, MO  64029





HOSTED WITH LOVE BY THEIR CHILDREN AND GRANDCHILDREN





YOUR PRESENCE ON THIS SPECIAL OCCASION IS THE ONLY GIFT THE COUPLE DESIRES.
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12/1	Kelsey Parkhurst


12/3	Mary Gabriel


12/4	Betty Basinger


12/5	Larry Chitwood


12/6	Ciara Carter


12/7	Virginia Browning


	Chad Chitwood


12/9	Tony Marchetti


12/10	Caton Day


	James Strickler


12/11	Neal Seyfert


12/12	Robert Hall


	Regan Porter


12/14	Alice Lee Hardman


	Kim Schick


12/15	Donald Basinger


Shawna Meierarend


	Elliott Zimmerman


	Kyler Zimmerman


12/16	Carter Day


	Donna Hall


12/18	Madi Huston


	Jeni Luttrell


Laura Shields


12/19	Orville Gott


Zack Zimmerman


12/22	Michelle Draper


12/23	Dolly Borgstadt


	Ashley Manns


12/24	Tim Ek


12/25	Jeanette Capranica


12/28	Carol Hazlett


12/29	Gail Fischer


Clint Huston


	Regan Rigby


12/31	Amanda Bloss


Matthew Coulson


	Janette Rector


	John Steiner
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12/5	Orville and Alice Gott


12/9	Louis and Judy Billups	


12/10	Jack and Janice Pittman


12/13	Dan and Jeanna Herrman


12/16	David and Brenda Keeton


12/19	Harvey and Rosalie Kolster


12/21	Josh and Sara Howard





* * * * * * * * * 
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DECEMBER OFFERING STEWARDS


	12/4	Mary Harper


	12/11	Don Caslavka


	12/18	Sarah Vaughan


	12/25	Jennifer Bell	 


_______________________________





DECEMBER USHERS & GREETERS


8:15 Service:	Janette & Hannah Rector


		Reva Lynch


10:45 Service:	Wayne & Debbie Neece


		Sarah & Jerry Vaughan



























































                    


















































            




















       














Inserting and Editing Pictures


Type your sub-heading here


You can replace the pictures in this template with your company’s art. Select the picture you want to replace, point to Picture in the Insert menu, and click From File. Choose a new picture and then click Insert. Select the Link to File box if you don’t want to embed the art in the newsletter. This is a good idea if you need to minimize your file size; embedding a picture adds significantly to the size of the file.


To edit a picture, click on it to activate the Picture toolbar. You can use this toolbar to adjust brightness and contrast, 





change line properties and crop the image. For more detailed editing, double-click on the graphic to activate the drawing layer. (





More Ways to Customize This Template


Footers


To change the text at the very bottom of each page of your newsletter, click Headers and Footers on the View menu. Use the Header and Footer toolbar to open the footer, and replace the sample text with your own text.


Insert Symbol


It is a good idea to place a small symbol at the end of each article to let the reader know that the article is finished and will not continue onto another page. Position your cursor at the end of the article, click Symbol on the Insert menu, choose the symbol you want, and then click Insert.


Borders


You can use page borders and text box borders to change the appearance of your newsletter. Borders on text boxes help keep different articles separate, and can set off sidebar articles from the rest of the page. To change a text box border, select it, double click its edge and choose the Colors and Lines tab in the Format Auto Shape dialog box.











Christmas  Cantata


December 11, 8:15 & 10:45 am





LOGOs Children’s Program


December 21, 7:00 pm





Christmas Eve Services


6:00, 8:00, 11:00 pm





Christmas Day Service - 6:00 pm





New Year’s Watch Party


December 31, 8:00-midnight





New Year’s Day Service – 10:45 am
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